USING SCORERS WITH
BRIDGEMATE II

There are 4 elements to know about:

a. The Server

b. The Bridgemate scoring devices (i.e. the units that are put on each bridge table)

c. Scorer program (IndScorer, PairsScorer, TeamsScorer, SwissPairsScorer or SwissTeamsScorer)
d. Bridgemate Control Software program (BCS)
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1. Setting up the Bridgemates

a.

When you switch on a Bridgemate there is a battery indicator in the upper left corner.
Full batteries are indicated with a full indicator. If the battery power is extremely low,
the battery indicator will show an empty battery and the indicator starts blinking. If
necessary replace the 2 AA batteries. Do not mix new and old batteries or batteries of
different types. The average battery life is 400-500 sessions.

You can set up the Bridgemates to have a fixed table number or you can allow North to
enter the table number at the start of the session. The advantage of the latter option is
that you can give out the Bridgemates as tables fill up and then decide on the table
layout and movement at the last minute. It is also easier to cope if a Bridgemate needs
to be changed during the session.

The Bridgemates have 4 function keys just below the screen. The menu on the screen
will show what each function key does.

To setup the Bridgemate, press OK to switch on the Bridgemate and then press the
“Setup” function key. The middle two function keys will scroll down and up the menu
items. To allow North to enter the table number move to the “Section” menu item.
Then press the — key until the word “Scan” appears. To set a fixed table number, press
the + key until the correct section (normally A) appears and then scroll down to the
“Table” menu item and press the + key to choose the table number.

The only other menu item that you are likely to need is the last “Contrast” one. Press
the + or - key to increase or decrease the contrast.

Press the “Back” function key to exit from the setup screen.

You do not normally need to reset the Bridgemates. If necessary (usually after an
incomplete session), you can reset the Bridgemates for the Tables which are in the
specified movement using the ’Reset Bridgemates’ button in the Scorer on the
BridgeMate Scorer (BMScoring) > BCS Admin tab screen. Any Bridgemates that are
not in use for the current session will not be reset automatically. To reset them
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manually, press the “TDMenu” function key and then the “Reset” key and then press
OK.

2. The server

a. The server has a battery backup in case of a power failure. The batteries act as a back-
up while the server is in operation. This will ensure no data is lost during the session.
The batteries will operate for approximately 50 hours.

b. The “Battery status” light indicates the voltage level of the inserted batteries. Green
means sufficient power left, orange means batteries are half full, red means batteries
have less than 25% power left, and blinking red means immediate replacement is
required. The BCS program also displays the battery level.

c. If necessary replace all 4 AA batteries. Do not mix new and old batteries or batteries of
different types.

3. When the computer is switched off the USB/battery power light on the server will turn red.
The server will automatically switch off after one hour so you do not need to take any
further action. If you wish, you can switch the batteries off by pressing the small push
button next to “Battery OFF” for a few seconds until the light goes out.

4. PC Preparation

a. Check your PCs Power Settings, including hibernation to ensure the PC will not enter
power-safe or hibernation mode during a session. You should set the PC to ‘Never’ for
the main Switch off options.

b. Ensure you have the correct versions for BCS, BM2s and Server. These may be
downloaded from the web site at http://www.bridgemate.com. BCS program should be
installed at c:\program files\bridgemate pro\bmpro.exe. (Currently the latest consistent
versions are BCS 2.7.9, BM2 2.0.1 and USB 2.0.1d respectively)

5. Player Number Entry Preparation

a. On the Player Database screen, ensure National Bridge Organisation is set (to EBU).

b. On the Player Database>Player Management Tab, click the Download EBU Member
Lists button to ensure the latest EBU list is available to BCS. Normally, the Scorer
checks member number as a Player Id, then as an NBO number. Tick ‘Disable Player Id
Check’ box to omit the Player Id check,

6. Setting up the Movement
a. IndScorer, PairsScorer & TeamsScorer:

After creating a new event and filling the event details, set up the movement on the
Select Movement screen. Do spend a minute checking that you have set the correct
number of boards, the correct phantom pair, the correct number of boards, rounds to be
played, E/W Add etc. If you need to change the movement later, (e.g. a pair turn up
late) see sections 16 to 20. Note that PairsScorer does not insist on unique numbers at
the BM end. If clubs want E/W pairs to use table numbers, and want those numbers to
appear in the BM units, they may do so. You can add a number to E/W pairs, even in
unswitched movements and if you add a fixed amount sufficiently greater than the
number of tables e.q.20, then you can easily switch from say a 14-table to a 15-table
standard Mitchell movement during play without affecting earlier pair numbers!

b. SwissPairsScorer, SwissTeamsScorer:
After creating a new event and entering event details, set up the movement on the
Event Details > Movement screen. Do spend a minute checking that you have set the
correct sessions, sections, boardsets, rounds, scoring method/scale etc to be played. On
the Assignments screen, set any sitters, missing pairs, swiss teams triple, swiss pairs
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current round/round in arrears etc as necessary and do the first Round Assignments. At
the end of each round, you will return to this screen to do the next round assignments.

7. Starting BCS

a. On the BMScoring screen, click the Set BCS Options button to set Bridgemate options
(such as whether you want to show the scores from the perspective of North-South or
declarer). Note that once the club has chosen the options it prefers, they should be
saved as Club Defaults and there should be no need to change them again. The options
may vary with the type of competition. The Name Source should be set to ensure
numbers are checked by BCS accordingly (against Local/National Databases). You also
need to set the BCS location and Table Top Unit type (Bridgemates) on the BS Admin
tab.

b. On the BMScoring screen, click the Create Database button. Normally, reply ‘Y’ to
overwrite any existing Database file. (In a Recovery run, you would reply ‘N’ here to
retain that file). When you click the Launch BCS/Receive Results button (with Reset
Server ticked), BCS will start automatically.

c. Check the Server is connected and that all the Tables are added to the Server. They will
be marked in Red on the BCS screen. You can minimise the BCS display by simply
clicking on the minimize button towards the top right of the window.

ﬁ Bridgemate® Control Software - C:\Bridge Scorer Testing\RESZO10\1227S-1AFT.bws L C’_M

File Session Server Tools Help MinimEé button_
Results I Round monitor | Board monitor | Result matrix | Players |

a
] ID | Section | Table | Round | Board | Pair NS | Pair EW | Declarer | NS/EW
=]1 A 1 1 1 1 1 1 N
’ 2 A 2 1 2 2 2 2 N
3 & 3 1 3 3 3 3 N

Hardware version

-

d. The Scorer will show movement information on its Results and Reports tabs. Now is a
good time to give out the Bridgemates. Or, if they are already on the tables, tell the
players that they can now start using them. When a player at a table presses OK to
activate their Bridgemate the red blob turns to green on the BCS screen.

e. The players should now enter their membership numbers (or, for EBU clubs, their EBU
numbers) into the Bridgemate. When the user presses OK the players’ names are
displayed on the Bridgemate. Visitors can enter 0 and their numbers will be sorted later.

f. If there is a half table, make sure that the two players enter their numbers. With an EW
phantom pair, the Bridgemate will prompt only for N and S numbers. Similarly with a
NS phantom pair, the Bridgemate will prompt only for E and W numbers.

g. The Scorer has Results, Reports and Name Tabs which tells you what is going on. For
example, every time a result is received it updates the number of received results on the
Results screen.

8. Checking names
a. Member Number entry is polled every 10sec and automatically processed.

b. When all tables have entered their membership numbers, you can check for wrong or
missing names either on the BMScoring > Names Tab or by returning to the Scorer
Names screen. Make a note of any names that weren’t recorded and collect them
manually for later input.

c. You can correct/update names on the Scorer Names screen. In PairsScorer, names are
shown in table order for where players sit in round 1. You can change it to pair order if
you wish. (It will look the same for Mitchell-type movements since players take their
numbers from the table number, but it will be different for Howell-type movements
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where pair numbers bear no relation to the table number). When you have finished,
return to the BMScoring screen.

d. Alternatively, you can correct names simply using the Players Tab on the BCS screen.
9. Using the Bridgemate to show rankings and results summary.

a. As a BCS option, users can see their rank at the end of each round and/or at the end of
the session. Press the “Rank” function key which gives the ranks of the two pairs at the
table for that round. Note that the rankings are only approximate. The correct rankings
are the ones shown in the Scorer.

b. At the end of the session, after pressing “Rank”, users can press “Game summary” to
see their results. In PairsScorer and SwissPairsScorer, this will be either as match
points or as a percentage score (as set in BCS Options). The screen will initially show
the NS score. Press E/W to see the EW scores and press N/S to go back to the NS
scores.

10. Showing and Changing previous scores — Player options

a. If the players want to check a previous score for the current round they click on the
“Scores” function key. All the results for the round are displayed.

b. If one of the scores is incorrect the players can change it by clicking on the “Correc”
function key. Enter the board number to be changed. The score will then be erased and
the correct score should then be entered as normally.

11. Showing and Changing previous scores — in BCS

a. You may change or delete results displayed in the BCS result list. Right-click on the
appropriate result and select Edit score. A detailed screen will appear displaying all the
score data. You can now edit any of the fields the result: In the NS/EW box enter the
Declarer, NS/EW, Contract, Result and Lead. For the contract field, clubs = C,
diamonds = D, hearts = H, Spades = S, no trumps = NT, double = X, redouble =xx,
pass = PASS. Enter the Contract & Result & other corrections. To replace a score
with an artificial assigned score, edit the Contract & Results boxes so that they are
blank and then enter the assigned score in the Remarks column as 60%-40% or
whatever. You must untick the Processed flag to ensure that the Scorer will be
updated accordingly. If a board result is changed in BCS, the new result is not
transferred to the Server/Bridgemates.

b. To delete a board result, right-click on that result and select Delete score. To delete
Multiple scores simultaneously, press and hold the Ctrl key and use the left mouse
button to select the scores you would like to delete; right-click > delete. Deleted
scores will be deleted from the Scorer even if the score has already been read and will
also be deleted from the Server/Bridgemates.

12. Showing and Changing scores — in the Scorer

a. You do this in the Scorer by clicking Return and then clicking Enter Scores. Now you
can change scores using the Scorer as normal. When you have finished, return to the
BMScoring screen.

b. NOT PLAYED (10 on BMs) should only be used when a board is not scheduled to be
played. If you have a half-table in a pairs movement then you can either set the missing
pair at the set-up stage or you can leave it as a full movement and take care of the
sitout on each round. NOT PLAYED should never be used when a board has been
removed for slow-play or other reason. In this case an artificial score of average +/=/-
should be entered as the decision to remove a board is made as a ruling under 12C2(a).
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13. Showing and Changing scores — TD options

The TD has more options to change scores. The TD presses the “TDMENU” function key
and enters the TD pin code. You can set a new pin on the BCS Options screen before (or
during) a BCS run. Once into the TDMENU, there is a list of options.

0 Reset - when selected will reset the Bridgemate

1 Arbitral Score - Enter the board number. You will be prompted for the NS/EW scores.
Enter 4 or - for average-, 5 or = for average and 6 or + for average+.

2 Overview of Results - Shows all results already entered on a specific board at this table.
This may be used priorto possible correction of a score.

3 Erase - Erase a score entered incorrectly at this Table. Note the users can do this
themselves unless the Bridgemate options have been set to prevent it.

4 Table Status - Shows the status for that table, i.e. the section, table number, the current
round, the pairs at the table in that round and the boards to be played in that round.

5 Missing Boards - Shows the boards still to be played in the current round.

6 Score Recap - Shows the scores for all boards in that round.

7 Adjust contrast -. Press the — or + key repeatedly to adjust the contrast.
14. Board played the wrong way

a. In a 1-winner movement in particular (such as a Howell), a pair might play the board
the wrong way. For example NS should be 1 and EW 8 but it is played as NS 8 and
EW 1. Simply get the player sitting North (pair 8 in this case) to enter the score they
actually achieved. In SwissPairsScorer, you may need to Arrowswitch all the boards in
the set but it is easier to simply change the Assignments on the Assignments screen.

b. Now, using the Scorer, go to the relevant board on the Enter Scores screen. Find the
score for 1 v 8 (or whatever the actually pair numbers are) and click on the “NS Score”
box for that line. Now press ‘A’. You will see that NS change from 1 to 8 and EW
changes from 8 to 1.

c. Return to BMScoring to continue receiving results.
15. Displaying results

a. Use the Reports tab and click “Display Ranks” button to see the results for all scores
received so far. The results are recalculated as soon as a new score is received). (Note
that the Scorer has an option to cycle display results via the Reports tab).

b. It is fairly meaningless to display ranks for the early rounds since there will be few
results on the travellers.

16. At the end
a. You can check for missing scores on the BMScoring > Results or Reports tab.

b. Click on Return to the Scorer screen “Display Reports” to display and print out the
results.

17. Changing the movement completely (Pairs, Individual & Teams only)

a. Suppose you have set up a movement and activated the Bridgemates. Then you realise
that you need to change the movement. Perhaps you just got the wrong number of
tables or boards or perhaps an extra pair arrived slightly late.

b. Using the Scorer, go back to the Select Movement screen and start all over again. The
Scorer will ask for confirmation. When you return to the BMScoring screen, you can
use the Update Movement button from Round 1 to clear any received results and
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change the complete movement from Round 1 onwards. Pairs may have to re-enter any
early 1% round scores.

18. Setting next round movement (SwissPairs, SwissTeams only)

a.
b.

Go back to the Assignment screen and do the next round Assignments.

When you return to the BMScoring screen, use the Update Movement button from the
appropriate Round to change the complete movement from that Round onwards.

19. Changing the movement — Rounds played (Individual, Pairs, Teams only)

a.

Suppose you wish to curtail or extend the number of rounds played. Using Pairs Scorer,
return to the Select Movement screen. Ensure Retain Results is ticked, change the
number of rounds and then click on OK. Pairs Scorer will ask for confirmation.

Return to the BMScoring screen and use the Update Movement button to change from
an unplayed round onwards. (You can use the Read All Results button to get the
results back up to date if you forgot to Retain Results!).

20. Changing the movement — ArrowSwitch (Pairs only)

a.

b.

With a one-winner movement already set, the change is similar to changing the
movement for rounds played. You correct the Arrowswitch information on the Select
Movement screen, Update Movement in a similar way as 19b.

With a two-winner movement already set, the external pair numbers may change eg In a
two-winner 7 Tables Mitchell, NS and EW pairs are numbered 1-7. In a one- winner
movement, NS are normally 1-7, EW are 8-14. To avoid Pair number mismatches, you
should wait till the end of the current round. Return to the Select Movement screen.
Change the movement to a single winner. Tick Retain Results and click OK. Pairs
Scorer will ask for confirmation. Return to the BMScoring screen and use the Update
Movement button to change from the next unplayed round onwards. (It may be good
practice to always add a fixed number eg 100 to the EW Pair in all Mitchell
movements, and then you can easily switch without affecting Pair Numbers)

21. Changing BCS Options during play

a.

C.

You can change options for all tables during play. For example, you have a table
sharing boards. They may get a warning for each board played out of order. You can
remove the warning message for all tables.

From the BMScoring screen, click the “Set BCS Options” button and change the
appropriate options in either of the two tabs (“Bridgemate” and “Bridgemate 11”).

Click on OK.

22. Recovery

a.

b.

When things go wrong you should be able to recover. So if a Bridgemate fails, the
power fails, the server is switched off, BCS is closed down, the Scorer is closed down
etc, just follow the instructions in sections 24 to 27.

The results are stored in five locations namely, the Bridgemates, the server, BCS results
file (database on the computer), Scorer and in the BCS log file. It should always be
possible to recover the data from one of these locations. The results in the Bridgemates
and Server are deleted when you start a new session. The database, results in the
Scorer and BCS log file are kept permanently (until you choose to delete them).

23. A Bridgemate stops working

a.

If a Bridgemate stops working part way through a session, then it is very easy to switch
to another one. Before that, it is worth checking if one of the keys is stuck below the
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cover (most likely the ‘Accept’ key)? If so, release the button and try again. Also check
if the Display is turned down?

b. Take another Bridgemate and set to the correct section and table number. Also make
sure it is set to correct Channel. Activate this Bridgemate. It will inform you that the
table has been started by another Bridgemate. Press OK to proceed, enter TD PIN code
and press OK again. This Bridgemate has now replaced the old Bridgemate.

24. Recovery after the Scorer is closed down

Even if the Scorer is (accidentally) closed, BCS and the Bridgemates and the server will
continue to operate.

a. Restart the Scorer and retrieve the event to reload the existing session.

b. When you get to the BMScoring, click Create Database button (Reply ‘N’), click
Launch BCS button (with Reset Server unticked) to restart receiving. You will get a
warning ‘BCS is already running...’. The Scorer will now collect all the results since
the power went off.

25. Recovery after BCS is closed down or stops receiving data from Server

a. If the BCS program locks up or is (accidentally) closed, then click the Restart button,
click Create Database button (Reply ‘N”), click Launch BCS button (with Reset Server
unticked) to restart receiving. The Scorer will now collect all the results to continue
with the existing session.

26. Recovery after the Server loses the connection (Shows unconnected status)

a. If the Server loses the connection, unplug and plug back the USB cable and that will
recover most of the time.

b. If the Server is accidentally unplugged, it will still continue to run on battery and may
just be plugged back in. If you remove the server from the computer and switch off the
batteries then, obviously, the Bridgemates will no longer be able to communicate with
server. You can still recover.

c. Go to the BCS program. Click “Session”, “Synchronize / Recover”, click the
“Recovery” tab and then click “Recover server”.

Bridgemate® Pro Control

<P By recovering the server all current data in the server will be erased and the server will be synchronized bo the session database. Scores in the session database will
‘-—‘/ be stored in the server. Are you sure you wank to recover the server?

d. Answer “Yes”.

Bridgemate® Pro Control

e. Answer Yes. Enter the number as requested to reset the server. A box will appear
indicating what actions have been taken. Click “Close” and then everything should be
back to normal. All existing Server data will be deleted and overwritten with the tables
and scores contained in the Database.

f. Ensure BM2 is retrieving data. If not, then on the BCS Menu Bar use Session>Update
Movement (status now changes to retrieving). Bridgemates will still be red; press OK
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on bridgemates till they appear in green and you are back where you were when the
server lost the connection.

If a table has entered results when the server lost the connection, they will have to be
re-entered. Check on the Scorer’s BMScoring control screen for any outstanding
scores for the current round and advise any tables with missing scores to re-enter them
on the bridgemates.

27. Recovery after a Computer freeze or failure

a.

When a PC freezes. the biggest problem is when it cannot be closed down using any of
the normal Windows methods (File > Exit, Alt+F4 etc). To get round this Press Ctrl +
Alt + Del. This will bring up the Windows Task Manager. Select the program (often
there will be a note beside it saying that it is not responding) and click on End Task.
The program should then close down. If the Windows Task Manager cannot be
invoked, then you can close down the computer by holding the power key/button down
for 5-10 seconds. You will need to restart the Scorer from scratch but remember not to
overwrite the Database.

If there is a computer failure the Bridgemates and the server will continue to operate.
You can run the Scorer on the same computer by applying the recovery steps for
Scorer, BCS and Server closedown (Refs 24,25,26).

Alternatively you can run the Scorer on another computer and recover all the results by
applying the following steps on the new computer as follows.

DO NOT CONNECT THE SERVER TO THE NEW COMPUTER YET.

Start the Scorer and set up the session exactly as on the old computer. Go to the Bridge
Mate Scorer screen, click Create Database (Reply ‘N’ button and Launch BCS (with
Reset Server unticked). When BCS starts you will see in the top left hand corner that
the server is not connected.

Now connect the server to the new computer. After a few seconds, BCS will indicate
that the server is connected. Scores queued in the server since the computer failure will
be read.

Now go to the BCS program. Click “Session”, “Synchronize / recover” and then click
“Synchronize”. This copies all the server data back to BCS.

To read scores before the failure, click on “Server”, “Show tables”. Now select all the
tables. The simplest way to do this is to click on the first table, hold down the shift key
and then press the End key. Right click whilst on the list of tables and left click on
“Retrieve scores”. You should now have all the scores. Minimize BCS and continue as
normal.

Unfortunately there is no facility in BCS to recover member numbers. Names will have
to be entered into the Scorer manually.

28. Retrieving results from the BCS Database File

If the BMs ran to completion but the Scorer has no results or missing results, you can
retrieve them from the BCS Database File. You don’t need a Server or BMs to do this.
You just retrieve the event, go to the BMScore Screen, Create Database (reply N to
Datbase already exists), and Read All Results.
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29.

30.

31.

Retrieving results from the Server

If the Scorer has no results or missing results, it is possible to retrieve them from the server
and to read them in the result file. The first step is to check whether the results are still
stored on the server.

If BCS is not running, the recommended method is to launch BCS from the Windows Start
menu > All Programs > Bridgemate Il. Once BCS is started up, go to the File > Open
menu and select the result file you used for your session.

If BCS is running, use the Server > Show all scores menu for this purpose. All the results
stored in the server will now be shown.

If the correct results are shown, it is possible to read them manually using the Server >
Show tables menu. Select all tables (hold down the left mouse button and the Shift key)
and press “Retrieve scores”. The results of the selected tables are retrieved from the server
and processed in the result file. The results can now be read by the scoring program.

Retrieving Results from the Bridgemates

The board results are stored in the internal memory of the Bridgemate and can be resent to
the server. Results can be resent from both the TD-menu and the setup menu. Proceed as
follows:

1. Make sure the server is connected, and is loaded with the session data (tables,
movements). When all data in the server was lost as well, restart the Bridgemate Il scoring
system from your scoring program in order to load the session data back in the server.

2. a) Bridgemates which are still in result entry mode can resend the results from the TD-
menu. Access the TD-menu with the TDMENU function key and PIN code, and press
RESEND function key.

2. b) Bridgemates which show the main screen can resend the results from the setup menu.
Press SETUP function key to access the setup menu, press INFO function key, followed by
RESEND function key.

3. The number of board results in the Bridgemate memory is displayed. Press OK to start
the retransmission. Retransmission will only succeed when the server is activated and
contains the session data.

4. After retransmission, the board results can be posted in the scoring program using the
normal procedures.

Once the Bridgemate has been started up again for a new session and the first result is
entered and confirmed, the memory is erased and all the data removed. Ensure that no
players are operating the Bridgemates at the end of the session to avoid a possible loss of
data.

Retrieving Results from the Log File

A last resort is to look in the Bridgemate log which shows all the results for all the
sessions. The log file is called BMProLog.log, is located in the Bridgemate Control
Software folder, normally C:\Program files\Bridgemate Pro. (It is usually in the Virtual
Store folder which Windows creates in the User folders and stores files there if users don’t
have rights to write in the Program Files folder. Having got to the Bridgemate Pro folder,
Vista and Windows 7 users will need to click on “Compatibility Files” to see the log file).
Results can also be retrieved from the log file.Use a textfile editor (eg Notepad) to copy
the selected rows and save to an empty text file and print. Automatic processing is not
possible; the results must be entered manually in the scoring program. To view the log file,
go to the Tools > Show log file menu.
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